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(2½ Hours)       Solution QP code 64596 APR_2019-R-SEM-VI-75-25                 [Total Marks: 75]                                      
                                     Subject Code 83020 
Note: 1) All questions carry equal marks and are compulsory. 
           2) Figures to the right indicate maximum marks for a question.  
            
Q1.  (A)  Attempt  any two  sub-questions from a), b) and c) in MS-EXCEL 

(True or False) 
(2) 

  a) The result of a logical formula is a numeric value. F 
  b) The Trim( ) function removes all blank spaces from the string argument. T 
  c) Solver problems are limited to a single changing cell. F 
     
 (B)  Attempt  any two  sub-questions  from d), e) and f) in VISUAL BASIC 

(Multiple Choice) 
(2) 

  d) Double clicking on the command button icon in the tool box will _________.  
   A) Do nothing        B) Highlight it        C) Place it on the form     D) Delete it  

  e) ___________is the final keyword used to indicate the end of a sub procedure.  
   A) Exit Sub               B) End Sub              C) Exit                                D) Quit  
  f) The full form of VBP is ________.  
   A) Visual Binary Project                   B) Visual Basic Project  
   C) Very Basic Project;                   D) Visual Basic Parameter  
     
 (C)  Attempt any six  sub-questions from g), h), i), j), k), l), m), n), o) in  

E-Commerce. (True Or False). 
(6) 

  g) Transaction broker earns money in the form of commission each time a 
transaction occurs. 

T 

  h) Richness refers to the total amount of information that is available to all 
the stakeholder.  

F 

  i) Content provider is one of the major B2B model. F 

  j) In SET the customer’s credit card number is never seen by the merchant. T 

  k) Integrity refers to the ability to determine the origin of the message 
received over the Internet.  

F 

  l) The cost of the products sold through E-Commerce is very high. F 

  m) In SSL, encryption is based on session key which is unique and is different 
for each session. 

T 

  n) M-Commerce means buying and selling of goods and services using a 
laptop. 

F 

  o) Digital signature is used to authenticate the identity of a person involved in 
Ecommerce.  

T 

     
 (D)  Attempt any five  sub-questions from p), q), r), s), t), u), v), w) in E-

Commerce. (Multiple Choice) 
Please note for sub question u) both A and D is correct. Please give marks if 
student selects either of them or both of them. 

(5) 

  p) Yahoo is a ________________.  
   A)Portal        B)E-Tailer            C) Transaction Broker D) None of these  
  q) In __________ E-Commerce one business makes deals with another Business.   
   A) C2C           B) B2C                   C) B2B                                      D) C2B  
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  r) The model in E-Commerce where companies earn revenue by referring 
users to other websites providing products/services is called _______________ 
model. 

 

   A) Advertising           B) Affiliation               C) Sales                     D) Transaction  
  s) The full form of SET in E-Commerce is __________________.  
   A) Secure Electronic Tax                B) Secure Electronic Transaction 

C) Secure Electronic Territory  D) Secure Electronic Tunnel 
 

  t) Conversion of coded data into readable data is called _________________.  
   A) De-conversion B)Decryption            C)Encryption         D)Password  
  u) The sender and receiver will have the same key in _________Key encryption  
   A) Symmetric               B) Asymmetric         C) Public         D)Private  
  v) _____________ are sites that create a digital online environment where people 

with similar interest can do transaction. 
 

   A) Community Provider                       B) Market Creator 
C) Portal                                                    D) Service Provider 

 

  w) A Computer to Computer exchange of business transaction is called ______.  
   A) E-Business           B)Super Market            C)EDI                      D)E-Market  
     
Q2. (A)  Answer any one sub-question from a) and b) in E-Commerce. 

Students need not write exactly as the given answers, they can write 
answers in their own words. Please give marks as long as content is correct. 

(8) 

  a) Explain the features of E-Commerce. 
(Give full marks if any four features are explained, 2 marks for each feature) 
ANS: The important features of E-Commerce as listed below. 
Ubiquity: 
When we say that E-Commerce is ubiquitous, it means that it is available 
just about everywhere and at any time. It removes the boundaries of space 
and makes it possible to shop from the confines of your home or office and 
even when travelling by various modes of transport. Hence it liberates the 
market from any physical space that we normally associate with carrying 
out commerce. 
Global Reach: 
E-Commerce technology permits commercial transactions to cross various 
cultural boundaries, as well as the geographical boundaries that have been 
made by mankind across the globe. Hence the size of the market that is 
available for E-Commerce includes the entire population which is going 
online.  
Universal Standards: 
The technical standards used in E-Commerce are universal standards i.e. 
they are used all over the world. This is chiefly due to the fact that the 
technical standards used in the internet are universal standards, which are 
accepted and shared all over the world.  
The use of these universal standards in E-Commerce has resulted in a great 
reduction in the costs involved in searching for products, as they can be 
viewed by one and all.  
Interactivity: 
 The technologies used in E-Commerce are interactive i.e. they allow a two 
way communication between the parties involved in the transaction, which 
are the merchant making the sale and the buyer. For example, a website 
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may ask the consumer to fill in a form and depending on the data entered 
in that form, various options are displayed, from which the consumer can 
choose the appropriate one.  
Richness: 
Richness refers to the complexity and content of information on a product, 
which is traded in E-Commerce. Using audio and video the richness of the 
information that is given is greatly enhanced. This, in turn, becomes a 
powerful tool for selling in the commercial environment. 
Information Density. 
Information density refers to the total amount and quality of information 
that is available to all the stakeholders (market participants, consumers 
and merchants). The wide use of E-Commerce has greatly reduced the cost 
of collection of information, its storage, processing and communication.  
Personalization. 
This enables the merchants and traders to have better information of the 
requirements in the market, due to which they can modify their marketing 
strategies. Due to the interactive nature of technology used in E-
Commerce, the past preferences and behavior of the user is known. This 
enables merchants to customize i.e. give the product or service as desired 
by the user. 

  b) Explain the following B2C models in E-commerce. 
 (i) E-Tailer                (ii) Content Provider          (iii) Transaction Broker    
(Any one 3 marks, any two 6 marks all three 8 marks) 
 (i) E-tailer : 
The customers and the seller interact directly, it includes 
• Organize an online catalogue of products 
• Take orders through Web site 
• Shopping cart technology 
• Accept payments in a secure environment 
• Send merchandise to customers 
• Manage customer data 
• Market Web site to potential customers 
• Revenue through product sales 
• Low barriers to entry -> very competitive 
(ii) Content providers : 
Content providers distribute digital content (news, music, video and 
artwork) over the Web. Revenue is generated through subscription fees, 
pay for download, or advertising.  
(iii) Transaction Broker : 
Sites that process transactions for consumers. It primary value proposition 
is saving of time and money for customers. It is a typical revenue model 
with a transaction fee is charged for facilitating transactions.  
Industries using this model: 
• Financial services 
• Travel services 
• Job placement services    

 

     
 (B)  Answer any one sub-question from c) and d) in E-Commerce (7) 
  c) What is M-commerce? What are its applications?  
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(If definition (1 mark)and any 3 applications (2 marks each) explained give 
full 7 marks) 
Mobile Commerce commonly called m-commerce, means buying and 
selling of goods and services through wireless handheld devices such as 
mobile phones and Personal Digital Assistants (PDA). M-Commerce is 
about the growth of applications and services that have become accessible 
from internet enabled mobile phones. M-commerce is popularly called the 
next generation of E-Commerce. The technology used to bring internet 
content and services to mobile phones and other wireless devices is called 
Wireless Application Protocol (WAP). 
Applications of M-Commerce are 
1. Brokerage Services. Stock prices are regularly displayed on the mobile 
device and are available even when the person is on the move. Based on 
these stock quotes trading can be conducted directly from the mobile 
phone. 
2. Financial Services. This includes mobile banking where bills can be paid 
using the mobile phone and customers have access to their bank accounts 
while they are on the move. 
3. Retail and Services. This enables the mobile phone users to order for and 
pay for various services while on the move. 
4. Information Services. This includes the sending of cricket scores, jokes, 
news, astrology etc. and even traffic updates. 
5. Reservations. Here the mobile phone is used to make reservations in 
airlines and hotels. 
 

  d) Explain SET protocol. 
ANS: The Secure Electronic Transaction (SET) is a protocol developed by 
Visa and Master Card to full proof the online Credit Card transactions and 
to provide security in terms of Confidentiality, Integrity and Authenticity of 
the transaction.  
The main features of SET protocol are as follows: 
1. In a SET protocol all the sensitive information sent between the 
customer, the merchant and the merchant’s bank is encrypted. 
2. All the above three parties have to get themselves authenticated by the 
SET certificate authority.  
3. The customer’s credit card number is never seen by the merchant. 
SET covers all the aspects of online commerce. It authenticates the 
identification of the parties involved in the transaction by using a 
combination of cryptography system along with digital certificates.   

 

      
Q3. (A)  Answer any one  sub-question from  a) and b) in MS-EXCEL (8) 
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  a) Consider the following worksheet in Excel 
 A B C D E 
1 Name Total Sales Commission Bonus Total Earning 
2 Karan 85000    
3 Anitha 63000    
4 Sharan 248000    
5 Megha 125000    
6 Pratham 260000    
7 Suhas 75000    

Write the steps to  
i) Calculate Commission in column C using the following Commission 
Policy. 

Sales Amount Rate of Commission 
First   50,000    8% 
Next   75,000   10% 
 Excess   12% 

 ii) Calculate Bonus as 4% of the total sales whenever the sales is above 
Rs.2, 00, 000 otherwise no bonus is given. 
iii) Total Earning = Commission+ Bonus 
Commission: 
1. Select C2 and type 
=IF(B2<=50000,B2*8%, IF(B2<=125000,50000*8%+(B2-
50000)*10%,50000*8%+75000*10%+(B2-125000)*12%))and press 
enter. 
2. Select C2 and drag the fill handle to C7. 
Bonus: 
1. Select D2 type =IF (B2>200000, B2*4%, 0) and press enter.  
2. Select D2 and drag the fill handle to D7. 
Total Earning: 
1. Select E2 type = C2+D2 and press enter. 
2. Select E2 and drag the fill handle till E7.                             MARKS(4+3+1) 
 

 
 
 
 
 
 
 

  b) Roll Number and marks are entered in columns A and B as shown in the 
following worksheet. Write steps to compute Grade and the Division for 
next year in Column C and D respectively using HLOOKUP function. Policy 
table to be referred for finding Grade and Division for next year is given in 
the range G1:J3. 

 A B C D E F G H I J 
1 RNO MARKS GRADE DIV  MARKS 0 40 70 80 
2 23 86    GRADE F D A O 
3 32 74    DIV FAIL DIV C DIV B DIV A  
4 43 34         
5 56 44         
6 67 79         
7 70 98         
8 87 77         

i) For Grade 
1. Select C2 and type the formula 
=HLOOKUP(B2,$G$1:$J$3,2,TRUE) 
        OR   =HLOOKUP(B2,$G$1:$J$3,2) 
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        OR    =HLOOKUP(B2,$G$1:$J$2,2,TRUE)   
        OR    =HLOOKUP(B2,$G$1:$J$2,2)   
2.  Select C2 and drag the fill handle to C8. 
(ii) For Division 

1. Select D2 and type the formula 
  =HLOOKUP(B2,$G$1:$J$3,3,TRUE) 
        OR   =HLOOKUP(B2,$G$1:$J$3,3) 
2. Select D2 and Drag the fill handle to D8                                     MARKS (4+4)                                                                                               

     
 (B)  Answer any one  sub-question from  c) and  d) in MS-EXCEL (7) 
  c) Consider the following worksheet in Excel. 

        A B C D E F 
1 Name Basic Salary City DA HRA  Gross 
2 Anita 18650 Mumbai    
3 Sachin 29300 Pune    
4 Sunil 61000 Hyderabad    
5 Nirmal 50500 Mumbai    
6 Alpa 40000 Pune    

Write the steps to compute the following:- 
i) DA as 125% of basic salary whenever the basic salary is 30,000 or less 
otherwise as 135% of the basic salary.   
ii) HRA is 25000 for “Mumbai” city and 18000 for other cities.  
iii) Gross = Basic Pay + DA + HRA 
(i) To compute DA. 
1. Select D2 and type the formula 
     =IF(B2<=30000, B2*125%, B2*135%) and press enter. 
2. Select D2 and drag the fill handle to D6. 
 (ii) To find HRA. 
1. Select E2 and type the formula  
      =IF(C2=”MUMBAI”, 25000, 18000) and press enter. 
2. Select E2 and drag the fill handle to E6. 
(iii) To find Gross Salary 
1. Select F2 and type  
      =B2+D2+E2 and press enter.  
2. Select F2 and drag the fill handle to F6.                              (Marks 3+3+1)   

 

     
  d) Consider the following worksheet showing the electricity consumption in a 

building  
 A B C D E F G H I 
1 Flat Units Rate Unit 

Consumption  
Charges 

Fixed  Bill 
Amount 

 Units  Rate 

2 101 50   65   0 2.60 
3 102 120   90   100 5.62 
4 201 600   300   300 7.20 
5 201 340   150   500 8.95 
6 301 245   90     
7 302 700   300     
8 401 45   65     

 



 
 

 7  

  

 

Write steps to compute the following 
i) Find Rate using VLOOKUP function. Policy table to be referred is in the 
range H1:I5 
ii) Calculate Unit Consumption  Charges in column D where Unit Consumption  

Charges = units * rate 
 iii)Bill Amount= Unit Consumption  Charges + fixed charges 
i)To find Rate  

1. Select C2 and type the formula 
=VLOOKUP(B2,$H$2:$I$5,2,TRUE) 
OR =VLOOKUP(B2,$H$2: $I$5,2) 

2. Select C2 and drag the fill handle to C8. 
ii)To calculate Unit Consumption  Charges 

1. Select D2 and type the formula   =B2*C2   
2. Select D2 and Drag the fill handle to D8. 

iii) To calculate Bill Amount 
  1.  Select F2 and type the formula = D2+E2 

2.  Select F2 and Drag the fill handle to F8.                            MARKS (4+2+1) 
     

     
Q4. (A)  Answer any one  sub-question from  a) and b) in MS-EXCEL (8) 

  a) The following table shows the shipment forecast of tablets, laptops and 
Desktop PCs worldwide for the year 2015, 2016, 2017and 2018. 

 A B C D E 
1 PRODUCT 2015 2016 2017 2018 
2 DESKTOP 113.6 103.3 97.8 94.4 
3 LAPTOPS 163.1 156.8 161.6 162.3 
4 TABLETS 208 174.9 163.7 150.3 
5 TOTAL     
      

Write the steps to 
 i) Find the total product shipped in the year 2015,2016,2017,2018 in the 
cells B5, C5, D5 and E5. 
ii) Create 3-D Bar chart for the year 2015,2016,2017,2018. 
iii) Create a Line diagram for the year 2015 and 2018 
iv) Create a Pie chart for the year 2017. 
i) Find the total product:                                                          (Marks 2+2+2+2) 
          1. Select B5 and type  
          =SUM (B2:B4) OR =B2+B3+B4 and press enter. 
          2. Select B5 and drag the fill handle to E5. 
ii) To create Bar chart for the data. 

1. Select the data B2:E4 (or A1:E4).   
2. From the Insert tab, select bar chart, then select sub type 3-D. 

iii) To Create a Line diagram for the year 2015 and 2018. 
1. Select the data B2:B4 and D2:D4 (or B1:B4 and D1:D4)  
2. From Insert Tab select Line and then select any Sub type.   

 iv) To create Pie chart for the year 2017. 
1. Select the data D2:D4 (or D1:D4) 
2. From the Insert tab, select Pie chart, then select any sub type. 
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  b) The following Excel worksheet contains the Sale Price Per Unit, and Units 
sold of some products in a year. Write steps in Excel to calculate Total Sales 
in column D and Grand Total in D5. 
For the company to break even, it has to achieve a total sale of Rs. 18, 00, 
000 in a year. Using solver, find out the number of units of each of these 
three products that should be sold in order to meet the desired target sale. 
Where Total Sales=Price*Quantity and Grand Total= Sum of D2 to D4 
 

 A B C D 
1 PRODUCT NAME PRICE QUANTITY TOTAL SALES 
2 PEN DRIVE 450 100  
3 CHARGER 500 125  
4 MOUSE 650 250  
5 GRAND TOTAL    

i) Total Sales 
1. Select D2 and type =B2*C2 and press enter. 
2. Select D2 and drag the fill handle to D4. 
ii) Grand Total 
1. Select D5 and type =SUM (D2:D4) and press enter. 
iii) SOLVER 

1. Select D5 and from the Data Tab select Solver. 
2. In the dialog box in the ‘Set objective’ option the cell D5 is already  

              selected. 
3. In the ‘To’ option select ‘Value of’ and type 18,00,000 in the text box. 
4. In the option ‘By Changing Variable cells’ text box enter C2:C4 
5. Then click on Solve. When Solver will obtain the result, click on ok.                          

                                                                                                                  (Marks 2+1+5) 

 

     
Q4. (B)  Answer any one  sub-question from  c) and d) in MS-EXCEL (7) 
  c) The following data has been entered in a Excel worksheet 

 A B C D E 
1 NAME GENDER AGE CITY SALES 
2 MUKUND M 25 SURAT 498000 
3 RAVEENA F 23 NASIK 575000 
4 SNEHA F 26 CHENNAI 378000 
5 PRAVEEN M 29 NASIK 600000 
6 VILAS M 32 KOLKOTA  645000 
7 ANIKET M 27 NAGPUR 792565 

 
Write steps in Excel to 

(i) To display only the rows where the sales is less than 40000. 
(ii) To display only the rows where the gender is “M”. 

     (iii)To display only the rows where the city name starts with “N”. 
Solution: 
(i) i) Display only those rows where the sales is less than 40000. 

        1. Select the data A1:E7. 
        2. From DATA Tab select Filter. 
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        3. Click on the drop down arrow of Sales and from number filter select 
‘less than’. 

       4. Type 40000 in the dialog box and click on ok. 
(ii)To display only those rows where the gender is “M”. 

  1. Select the data A1:E7 
  2. From DATA Tab select Filter. 
  3. Click on the drop down arrow of Gender and from Text filter select 
‘equals’. 
  4. In the dialog box select (or type) M and click on ok. 

iii) To display only those rows where the city name starts with “N”. 
  1. Select the data A1:D7. 
  2. From DATA Tab select Filter. 
  3. Click on the drop down arrow of City and from Text filter select 
‘begins with’. 
  4. In the dialog box type N and click on ok. 

  d) Explain the following functions in MS-EXCEL. 
1) DAY( ) 2) NOW( ) 3) YEAR() 4) DAYS360() 

5) CORREL() 6) COUNTA() 7)LARGE()  

ANS:  
(Give 1 mark if either definition or example or syntax is correct for each 
function) 
1) DAY ( ): Syntax: DAY (Date/Serial number)  
It Returns the day of the month corresponding to a serial number or date 
text. The day returned has a value from 1 to 31. Note: Date text can be 
given in place of serial number. 
e.g. =DAY (35) gives 4 and =DAY(“3-JUNE-2018”) gives 3. 
2) NOW ( ): It Returns the current system date and time. e.g. NOW( ) returns 

11/04/2019 11:48 

3) YEAR( ): Syntax: YEAR(Date / Serial number)  
It Returns the year corresponding to a serial number or date text. The year 
returned has a value from 1900-9999. 
e.g. =YEAR(35) gives 1900 and =YEAR(“3-JUNE-2018”) gives 2018 
4) DAYS360( ): Syntax: DAYS360(start_date, end_date, method)  
It Returns the number of days between two dates based on a 360-day year 
(twelve 30-day months), which is used in some accounting calculations. 
Use this function to help compute payments if your accounting system is 
based on twelve 30-day months. Method is used to indicate U.S. or 
European method. 
e.g. = DAYS360(“6/1/09”,”6/4/09”) gives 3.       
5) CORREL( ): Syntax: CORREL(array1,array2) 
It Returns the correlation coefficient between two data sets. 
e.g. If D1:D3 contains the values 45,34,67 and E1:E3 contains the values 
49,44,75 then CORREL(D1:D3,E1:E3) gives .983358 the correlation 
coefficient between these two data sets. We can also type 
=CORREL({45,34,67},{49,44,75}) which gives the same result .983358 
6) COUNTA( ): Syntax: COUNTA(range) 
It Counts the number of cells in a range that are not empty. 
e.g. COUNTA(D1:D5) gives 2 if there are only two values in the cells from 
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D1 to D5. 
7) LARGE ( ): Syntax : LARGE (array, k )  
It Returns the kth largest value in the data set. 
e.g. =LARGE ({45, 23, 67, 87}, 1) gives 87 the 1st largest value in this array. 
      =LARGE ({45, 23, 67, 87}, 2) gives 67 the 2nd largest value in this array. 

     
Q5. (A)  Answer any one  sub-question from  a) and b) in VISUAL BASIC 

Students can use different methods to solve VB questions. Label names, 
textbox names etc. are user defined, so can be different from given in this 
solution. Give full marks for correct answer even if it is not same as the 
solution given here. VB 6 .Text is not necessary so please give marks even if 
.Text is not written. 

(8) 

  a) Write a project in VB to design a suitable form which allows the user to enter 

Amount in Dollars and Rate of Conversion to Rupees and then calculate and 

display equivalent amount in Rupees. 

Controls and their properties: 

Object Property Value/Setting 

Form Name frmDtoR 

 Caption/Text Convert to Rupees 

Label Name lblD 

 Caption/Text Dollars 

Label Name lblRC 

 Caption/Text Rate of Conversion 

Label Name lblR 

 Caption/Text Amount in Rupees 

Text Box Name txtD 

 Text  

Text Box Name txtRate 

 Text  

Text Box Name txtR 

 Text  

Command Name cmdConvert 

 Caption/Text Convert 

Command Name cmdExit 

 Caption/Text Exit 

Code: 

        Private Sub cmdConvert_Click()                      

             txtR.Text = Val(txtD.Text)*Val(txtRate.Text) 

        End Sub     

               

        Private Sub cmdExit_click()                              

             End 

        End Sub 
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  b) Write a project in VB to design a suitable form which allows the user to enter 

Name and Basic Salary and calculate DA as 95% of Basic Salary whenever 

basic salary is less than 45000 otherwise 110% of Basic Salary using a 

„Calculate‟ button and display the result.  

   

Controls and their properties: 

 

Object 

 

Property 

 

Value 

Form 

 

Name 

 

frmDA 

 Caption/Text DA 

Label 

 

Name 

 

lblBS 

 Caption/Text Basic Salary 

Label Name lblDA 

 Caption/Text DA 

Text Box Name txtBS 

 Text  

Text Box Name txtDA 

 Text  

Command Button Name cmdCalculate 

 Caption/Text Calculate 

Command Button Name cmdExit 

 Caption/Text Exit 

Code:  

Private Sub cmdCalculate_Click() 

If Val(txtBS.Text) < 45000 Then 

txtDA.Text = Val(txtBS.Text)  * 95/100 

Else 

txtDA.Text = Val(txtBS.Text)  * 110/100 

End If 

End Sub 

 

Private Sub cmdExit_Click() 

End 

End Sub 

 
 

     
Q5. (B)  Answer any one  sub-question from  c) and d) in VISUAL BASIC (7) 
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  c) Write a project in VB to design a suitable form which allows the user to enter 

Product Name, Quantity Sold  and Price per Unit of a product and then 

calculates and displays the Total Cost  (Total Cost  = Quantity Sold  * Price per 

Unit)  

 

Controls and their properties: 

 

Object Property Value 

Form Name frmCost 

 Caption/Text Total Cost 

Label Name lblN 

 Caption/Text Product Name 

Label Name lblQ 

 Caption/Text Quantity Sold 

Label Name lblP 

 Caption/Text Price per Unit 

Label Name lblTC 

 Caption/Text Total Cost 

Text Box Name txtN 

 Text “  ” (blank) 

Text Box Name txtQ 

 Text “  ” (blank) 

Text Box Name txtP 

 Text “  ” (blank) 

Text Box Name txtTC 

 Text “ ” (blank) 

Command Button Name cmdCalculate 

 Caption/Text Calculate 

Command Button Name cmdExit 

 Caption/Text Exit 

 

Code:    

Private Sub cmdCalculate_Click() 

      txtTC.Text = Val(txtQ.Text) * Val(txtP.Text) 

End Sub 

 

Private Sub cmdExit_Click() 

     End 

End Sub 

 

 

 

  d) Write a project in VB to design a suitable form which allows the user to enter 

an integer and calculate and display the factorial of that integer when the 

“Calculate” button is clicked. 

(Factorial of N= 1*2*3----------*N) 

 

 

 

 

 
 



 
 

 13  

  

 

Controls and their properties: 

 

Object Property Value/Setting 

Form Name FrmFactorial 

 Caption/Text Factorial 

Label 1 Name lblN 

 Caption/Text Number 

Label 2 Name lblF 

 Caption/Text Factorial 

Text box1 Name txtN 

 Text “ “ (blank) 

Text box Name txtF 

 Text “ “(blank) 

Command Name/Text CmdFactorial 

 Caption Calculate 

Command Name CmdExit 

 Caption/Text Exit 

Code: 

Private Sub CmdFactorial_Click()                        

   Dim I, N, Factorial  As Integer 

   N = Val(txtN.Text) 

   Factorial=1 

   For I=1 to N step 1 

       Factorial= Factorial* I 

   Next  I 

   txtF.Text = Factorial 

End Sub 

 

Private Sub CmdExit_click()                        

   End 

End Sub 

 

     
 


